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重要 

本日本語マニュアルは、Biacore の用途別の典型的基本的操作手順を記載しています。装置の規制対

応、安全性注意事項、使用するセンサーチップやキット個別の詳細条件設定等は 、

cytivalifesciences.com 内各製品の Instruction For Use（IFU, 英語）を併せてご参照ください。

（各製品ページ“Related Documents”よりダウンロード） 
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 1. 実験を始めるまえに 

1-1. システムの起動 

手順 操作項目 注意点 

① 電源 On ・システム本体→PC の順 

② バッファー類のセット ・A ラインが main inlet tube 

③ コントロールソフトウェアの起動 

  Biacore X100 Control Software 

デフォルト User : admin / Pass : administrator 

 

 

 

扉を開ける 

ペリスターポンプのロック確認 

ランニングバッファー 廃液ボトル 

サンプルラック 

←メニュー/ツールバー 

←アッセイコマンド 

←ステータスバー 
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1-2. 測定前の基本操作・設定 

手順 操作項目 注意点 

① センサーチップのドック 自動的にセンサーチップポートが開かない場合は、

Toolbar のセンサーチップの絵のアイコンを押す。  

② ランニングバッファーによる prime Menu bar の Tools → Prime からスタート 

③ 温度設定 Menu bar の Tools → Set Temperature… 

*Plus Package のみ対応 

 

 

センサーチップのドック手順 

本体上部のセンサーチップ挿入部位の扉を開け、スライダーを手前に引きセンサーチップをセットする。スラ

イダーを装置に挿入する。 
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2. 基本操作 

2-1. サンプルラックの取り扱い 

手順 操作項目 注意点 

① ラックトレイの出し入れ 
・Toolbar の Load Samples アイコン を押す 

・rack locked のランプが点灯している際は、ラックを取り出すこと

ができないので注意。 

② 対応バイアル  

ラックを真上に持ち上げ取り出す。画面上に Load Sample ウインドウが表示される。ラックをセット後、OK

をクリックする。 

 

ラックを真上に持ち上げ取り出す。画面上に Load Sample ウインドウが表示される。ラックをセット後、OK

をクリックする。 

 

ラックには、サンプルバイアルを 15 本とニードル洗浄に利用

する超純水バイアルを１本セットできる。 

 

ラックには次のバイアルがセットできる。専用のキャップを利

用する。パラフィルムなどニードルの穴を塞ぐ可能性のあるシ

ールは使用しない。 

 

 

 

Rack position 1-15 H2O 

キャップ 
Rubber caps, type 2 
BR100411 

不要 

バイアル 

1.5ml Plastic Vials 
BR100287 

15mm Plastic Vials 
BR100654 
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2-2. 3 つの測定モード 

A. 測定モードの選び方 

測定モー

ド 

モード名称 特徴・用途 

①  Assay Workflow 

 

・実験ノートを使用する感覚で、実験結果を記録 

・流れに沿って各ステップのデータ取得 

・Kinetics/Affinity：詳細な分子間相互作用の評

価を実施したい 

・Binding Analysis：複数サンプルにおける結合の有

無を評価したい。 

・DMSO を含む低分子化合物では使用しません。 

②  Manual run 

 

・1 インジェクションごとにマウス操作で行う 

・サンプル消費量が少ないがラフなデータ 

・ラフな条件検討用 

・低分子測定の場合は（レスポンスが小さいので）

あまり使わない。 

・ka、kd、KD値などを解析ソフトウエアで解析できな

い。 

③  Wizards 

  

・典型的な定型の測定系を Wizard テンプレート形

式で作成する。 

・ワークフローより自由度の高い実験系を構築 

 

 

 

 

 

 

 

 

 

 

① ② ③ 
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B. Assay Workflow ソフトの操作のポイント 

Assay Workflow は Biacore X100 特長的な機能で、実験の全体像を、一つの実験ノートのようにまとめ

ながら測定を進めていくことができます。 

 

はじめに Kinetics/Affinity か Binding Analysis を選択します。 

手順 操作項目 注意点・説明 

① Ligand name リガンド分子の名称を入力します。 

② My Ligand is… 分子種、タグ付きのであるかなどの選択 

③ リガンドの詳細 抗体の場合：抗体の種類を選択 

タグ融合分子の場合：タグの種類を 

④ Ligand attachment 
approach 

お勧めの固定化方法の中から選択。Workflow を表示します。 

下図では、Sensor Chip SA を選択。 

⑤ Continue Workflow の保存 

 

 

① 

⑤ 

② 

③ 

④ 
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3. 測定系のデザイン 

3-1. 目的別の測定ワークフロー図 

 

 

3-2. 典型的な目的別リガンド固定化法 

 

センサーチップ SA への固定化⇒ 4-1 参照 

スクリーニング⇒ 4-2 参照 

Biotin CAPture kit を用いたキャラクタリゼーション⇒ 4-3 参照 

Amine Coupling を用いた固定化 （一般的にタンパク質変性リスクがやや高い）⇒ 6-1 参照 
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3-3. 固定化法の大分類（直接法とキャプチャー法） 
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4. 低分子化合物の目的別測定解析手順 

4-1. センサーチップ SA への標的タンパク質の固定化 

A. 手順概略 

手順 操作項目 参照 

① 標的タンパク質の Biotin 化 ・化学的 Biotin 修飾 （6-4 参照) 

・Avi-tag Biotin リガーゼシステムを用いた修飾→サプ

ライヤーのプロトコルをご参照ください。 

② センサーチップの選択  

③ Wizard テンプレートを用いた固定化 4-1C 参照 

 

B. 準備する試薬・サンプル 

各センサーチップの Instruction For Use (IFU)を併せてご参照ください 

一般的に固定化する Biotin 化タンパク質は pM~nM オーダー程度が適当ですが、サンプルや目標とする

固定化量により異なります。 
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C. ソフトの操作のポイント  

Wizards から、Surface preparation→Immobilization→New 

手順 操作項目 注意点・説明 

① センサーチップの選択 SA を選択します。 

② Prime before run 起動後、Prime 実施済みであればチェックを外す。 

③ 固定化アプローチの選択 ・通常 Fc2 に固定化をします 

・固定化量を下げて制御したい場合は Aim・・・を使うこともある 

④ リガンド名称 / 添加時間 各センサーチップ IFU参照。 

⑤ Rack Position 表示に従って分注（2-1 参照） 

分注後 Next→固定化開始 

 

 

 

① ② 

③ ④ 

⑤ 
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D 固定化量の確認と理論的 Rmax の算出 

方法 状況 固定化量の確認法 

① Wizard を利用 測定結果のウインドウ（Response Final）で確認する。 

② Manual run を利用 
・リファレンスライン  を用いて確認する（6-5 参照）  

 

理論的 Rmax [RU]= 固定化量[RU]×（アナライトの分子量/リガンドの分子量）×リガンドの結合価数 

アナライト添加時に十分なレスポンスが得られるか、実際にアナライトを添加したときのレスポンスが結合部

位特異的かどうかなどを見積もるために利用します。 

 

4-2. 低分子化合物のスクリーニング 

結合の有無を確認、ランキングなどを行う場合に実施します。 

 

A. スクリーニング測定を始める前に 

① ポジティブコントロールを用いた標的タンパク質の特異的結合の確認（6-9 参照） 

② Binding Analysis によるWork Flow 作成（2-2 参照） 

・低分子化合物を、結合レスポンスの高さで選出する。 

・選出アフィニティー基準（添加濃度）の目安 1μM~100μM 

 

B. 準備する試薬・サンプル 

 操作項目 用途、備考 

必須 ランニングバッファー メソッド作成時の画面から必要量を確認。加えて自動測定後の

stanby flow での放置時間分として 200 ml / 7 days 

必須 化合物アナライト溶液 選出したい化合物のアフィニティー基準を目安に添加濃度を設

定 

必須 50% DMSO 溶液 キャリーオーバー防止用洗浄溶液 

ほぼ必須 溶媒補正用溶液 DMSO を含まないバッファーの場合は不要 （6-6 参照） 

ほぼ必須 ポジティブコントロール 有れば必須。リガンド標的分子の活性確認 

オプション ネガティブコントロール ネガティブレスポンスの確認 

 

C. メソッドの作成  

Wizards から、Assay→Custom Assay Wizard→Biacore Template→

Binding analysis with solvent correction→Open 
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C-1. 添加条件等の設定 

手順 操作項目 注意点・説明 

① Detection ・Flow Cell に 1,2 を使用。 

・Reference subtraction にチェック 

② Chip ・Chip type として、今回は SA を選択 

③ Purpose ・スクリーニングの場合は、Binding Analysis 

④ Prime before run 起動後、Prime 実施済みであればチェックを外す。 

⑤ Solution 複数種類を評価するため、Varies by cycle をチェック 

⑥ 測定条件 Contact Time：アナライト添加時間／Dissociation time：解離時間 

Flow late：流速。通常 30 μl/min. 

Flow Path：通常は Both（Fc1,2 両方に流す） 

⑦ Extra wash 流路内アナライトのキャリーオーバーを防ぐ。低分子化合物では 50% 

DMSO を用いる。 

⑧ Solvent correction 溶媒補正溶液の濃度点数。4～8 点。（6-6 参照） 

 

 

① ② 

④ 

③ 

⑤ 

⑥ 

⑧ 

⑦ 
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【Tips】 低分子化合物のスクリーニング時には通常再生溶液の添加は行わない(行う必要がない)。 

C-2. サンプル個別条件の設定 

手順 操作項目 注意点・説明 

① Concentration Unit 濃度単位の選択 

② Cycle type 前頁の Cycle type に対応 

③ Cycle Purpose 各サイクルの目的。サンプル添加前に、Startup 3 回、Solvent 

correction 1 回を入れる。 

④ Sample 情報 前頁⑤の Varies に関する、名称、濃度、分子量を入力 

⑤ Rack Position 表示に従って分注（2-1 参照） 

分注後 Next→測定開始 

 

 

① 

② ③ ④ 

⑤ 
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D. スクリーニングプロットのデータプロセッシングと解析 

手順 操作項目 注意点・説明 

① 解析ソフトで Run

ファイルを開く 

 

・解析ソフト Biacore X100 Evaluation software 

デフォルト User : admin / Pass : administrator 

・run 終了時、自動的に立ち上がる 

・別日に解析の場合は.blr（結果ファイル）を Open 

② 溶媒補正  

Solvent Correction 

・6-6 参照 

・Evaluation→Add Solvent Correction→OK 

③ データ QC チェック ・④評価対象にしない異常サイクルを除外する。（右クリック→Exclude 

Cycle） 

・例えば、溶媒補正検量線範囲外の Plot や Binding to reference が大

きいもの、など測定者の運用ポリシーに合致する基準を設定。 

・画面左側のデフォルトのプロットまたはカスタム QC プロットを利用 

④ Plot の作成 通常 Y軸に Binding Relative response、X 軸に Cycle number 

⑤ Ranking Tools→Ranking を選択。 

1 点または 2点の閾値を設定して、ランキングを設定 

⑥ 結果のエクスポート ⑤を経たデータ Table 等を Excel形式でのエクスポート 

メニューバーの File→Export 

手順①~④ 

 

 

 

  

① 

② 

②フィッティングされた溶

媒補正の検量線の実プ

ロットに対する Chi2値 

②検体が示した

Ref Fcのバルク

レスポンス範囲 

③ 

④ 
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手順④～⑥データプロセッシング 

 

 

 

 

 

 

 

④ 

⑥ 

⑤ 

⑤ 
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補足：プロットの右クリックからセンサーグラム形状の確認 

Show Sensorgram を選択 

 

 

補足：Negative control, Blank の違いと設定例 

Negative control: 特異的結合が無いと想定される化合物 

Blank: 濃度 0 の sample 
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 4-3. 低分子化合物のキャラクタリゼーション 

（主に Biotin CAPture kit を用いた方法を例に）  

A. キャラクタリゼーション測定を始める前に 

A-1. アナライトの添加濃度・時間の設定（6-2 参照） 

A-2. 適切なメソッドの検討（下表参照） 

A-1 

アナライトの添加濃度・時間の設定（6-2 参照） 

A-2 

センサーチップ/キット 用途 

Biotin CAPture Kit 

（Sensor Chip CAP） 
・解離が遅い化合物から速い化合物まで 

・Single Cycle kinetics 

Sensor Chip SA ・解離が速い化合物（再生が不要）の場合 

・Multi Cycle による Affinity解析を行うケースが多い 

 

B. 準備する試薬・サンプル 

 操作項目 用途、備考 

必須 Biotin CAPture kit ・Kit 内 Biotin CAPture reagent を使い終わった場合は単品販

売有り。 

必須 Biotin 化標的タンパク

質（リガンド） 

・化学的 Biotin 修飾 (6-4 参照)  

・Avi-tag Biotin リガーゼシステムを用いた修飾→サプライヤーの

プロトコルをご参照ください。 

必須 ランニングバッファー メソッド作成時の画面から必要量を確認。加えて自動測定後の

stanby flow での放置時間分として 200 ml/7 days 

必須 化合物アナライト溶液  

必須 50% DMSO 溶液 キャリーオーバー防止用洗浄溶液 

ほぼ必須 溶媒補正用溶液 DMSO を含まないバッファーの場合は不要（6-6 参照） 

 

 

C. メソッドの作成  

Wizard から、Assay→Custom Assay Wizard→Biacore Template→Single 

cycle kinetics with solvent correction→Open 
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C-1. システムの準備 

手順 操作項目 注意点・説明 

① Detection ・Flow Cell に 1,2 を使用。 

・Reference subtraction にチェック 

② Chip ・Chip type として、今回は CAP を選択 

③ Purpose ・キャラクタリゼーションの場合は、Kinetics/Affinity 

④ Prime before run 起動後、Prime 実施済みであればチェックを外す 

⑤ Conditioning Biotin CAPture kit の場合、チェック 

  

C-2. 添加条件等の設定 - Capture1/2 （Sensor Chip SA の場合は不要） 

手順 操作項目 注意点・説明 

① Command in 
Kinetics 

Biotin CAPture kit の場合、Sample の前に Capture1/2 を、後ろに

Regeneration を追加する。 

② 測定条件 ・Capture1（Biotin CAPture Reagent の添加） 

Contact Time：300秒／Flow late：2 μl/min.／Flow Path：Both 

・Capture2（Biotin 化リガンドの添加） 

Contact Time：要検討／Flow late：10 μl/min.／Flow Path：Second 

 

① ② 

④ 

③ 

⑤ 

① 

② 
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C-3. 添加条件等の設定 – Sample/Regeneration/Solvent correction 

手順 操作項目 注意点・説明 

① 測定条件 ・Sample（アナライトの添加） 

Contact Time：要検討／Dissociation time：要検討／ 

Flow late：通常 30 μl/min.／Flow Path：Both 

・Regeneration（Biotin CAPture Kit 付属） 

Contact Time：120秒／Flow late：10 μl/min.／Flow Path：Both 

② Solvent correction 4 点に減らす 

  

 

【Tips】 Sensor Chip SA を用いた、解離の速い低分子化合物のキャラクタリゼーション時には、通常再生

溶液の添加（Regeneration）は行わない（行う必要がない）。 

 

 

 

 

 

 

 

 

 

 

 

 

② 

① 
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C-4. サンプル個別条件の設定 

手順 操作項目 注意点・説明 

① Concentration Unit 濃度単位の選択 

② Cycle type 前頁の Cycle type に対応 

③ Cycle Purpose 各サイクルの目的。サンプル添加前に、Startup 1～3 回、Solvent 

correction 1 回を入れる。 

④ Sample 情報 ・前頁⑤の Varies に関する、名称、濃度、分子量を入力 

・0 濃度を 2Cycle 設定する。 

⑤ Rack Position 表示に従って分注（2-1 参照） 

分注後 Next→測定開始 

 

 

 

 

 

 

① 

② ③ ④ 

⑤ 
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D. 解析（KD、ka、kdの算出） 

手順 操作項目 注意点・説明 

① 解析ソフトで Run ファ

イルを開く 

 

・解析ソフト Biacore X100 Evaluation software 

デフォルト User : admin / Pass : administrator 

・run 終了時、自動的に立ち上がる 

・別日に解析の場合は.blr（結果ファイル）を Open 

② 溶媒補正 

 Solvent Correction 

・6-6 参照 

・Evaluation→Add Solvent Correction→OK 

③ 特異的結合の確認 センサーグラムの確認（6-7 参照） 

 

④ Kinetics / Affinity 
→Kinetics  

センサーグラムの解離相の形状が一定の遅さで降下し ka、kd の算出が

可能な場合に適用 

④ Kinetics / Affinity 
→Affinity  

センサーグラムの解離相の形状が瞬時に降下して“箱型”である場合に

KD値のみの算出を目指す場合に適用 

手順①~④ 

 

 

 

  

 

 

 

 

 

 

① 

② 

②フィッティングされた溶

媒補正の検量線の実プ

ロットに対する Chi2値 

②検体が示した

Ref Fcのバルク

レスポンス範囲 
③ 

④ 
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手順④-1Kinetics 解析 

手順①～② 

 

 

 

 

 

手順 操作項目 注意点・説明 

① 解析対象サンプ

ル等の選択 
・Tool bar の を選択 

・Sample：解析対象の選択 

・Curve： Fc=2-1 corr（DMSO correction を行った場合）、Fc=2-1（行

わなかった場合）を選択 

② ブランク（ 0 濃

度）の選択 

サンプルと同一名称の 0濃度が無い場合、ほかのシリーズから選択 

③ センサーグラムの

一部削除（オプ

ション） 

・アナライト添加の切り替え時に発生するスパイクノイズの削除 

・一時的に異常形状になったセンサーグラム領域の削除 

右クリックで領域指定→Remove Selection 

④ Kinetics 
を選択 

⑤ フィッティング条件

の設定→実行 

・Model：解析モデルの選択（6-9-1 参照） 

・Parameters：(6-9-1 参照) 

・Fit：Fitting対象のセンサーグラムの選択 

⑥ 解析結果の評価 6-10-1 参照 

① 

② 
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手順③～④ 

 

手順⑤～⑥ 

 

 

 

③ 

③ 

④ 

⑤ 

⑥ 
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手順④-2 Affinity 解析 

手順①～② 

  

 

  

 

手順 操作項目 注意点・説明 

① 解析対象サンプ

ル等の選択 
・Tool bar の を選択 

・Sample：解析対象の選択 

・Curve： Fc=2-1 corr（DMSO correction を行った場合）、Fc=2-1（行

わなかった場合）を選択 

② ブランク（ 0 濃

度）の選択 

サンプルと同一名称の 0濃度が無い場合、ほかのシリーズから選択 

③ Affinity 
を選択 

④ Setting ・レポートポイントの設定 

・デフォルト設定：添加終了 4 秒前を必要に応じて変更 

⑤ フィッティング条件

の設定→実行 

・Model：解析モデルの選択（6-9-1 参照） 

・Parameters：(6-9-1 参照) 

・Fit：Fitting対象のセンサーグラムの選択 

⑥ 解析結果の評価 6-10-1 参照 

① 

② 
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手順④ 

 

手順⑤～⑥ 

  

④ 

⑤ 

⑥ 
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５. メンテナンス・システムチェック・シャットダウン 

５-1. メンテナンス 

A. 日常のメンテナンス（システム洗浄）の種類 

毎週 Desorb （Menu bar の Tools → More Tools…内(下図)）に従い実行 

毎月 Desorb and Sanitize（Menu bar の Tools → More Tools…内(下図)） 

 

 

B. 準備する試薬、消耗品・注意点 

Desorb : (D)  
Desorb and Sanitize (D&S) 

必要試薬・消耗品 

D、D&S BIAmaintenance Kit  

・Desorb solution 1 は室温保存 

D、D&S Maintenance chip または使用済みのセンサーチップ 

D&S 次亜塩素酸ナトリウム（研究用試薬） 

終濃度 0.6～1.0%に用事調整。 

D、D&S ランニングバッファーまたは超純水 
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C-1. Desorb（毎週）の手順 

手順 説明 

チップのドック Maintenance Chip (または使用済みセンサーチップ)の Dock 

温度設定 20℃以上（通常 25℃）に設定 

ウイザードの実行 ウイザードに従い Desorb solution 1, 2 をサンプルラックにセット 

（所要時間） 約 20 分 

実施後次の実験前 

 

・自動的に Stanby flow（200 ml / 7days） 

・次の実験前に 3-4時間以上の Stanby flow か Prime の 3回実施 

 

C-2. Desorb and Sanitize（毎月）の手順 

手順 説明 

チップのドック Maintenance Chip (または使用済みセンサーチップ)の Dock 

温度設定 20℃以上（通常 25℃）に設定 

ウイザードの実行 洗浄溶液は装置左のインレットチューブから吸引されシステム全体を洗浄 

（いくつかのステップを下図に例示） 

（所要時間） 約 1 時間 

実施後次の実験前 ・自動的に Stanby flow（200 ml / 7days） 

・次の実験前に 3-4時間以上の Stanby flow か Prime の 3回実施 

 

・(Step 1, 2)Desorb Solution を装置左側のインレットチューブ用（10ml）に設置 

 

・(Step3) 同様に調整した次亜塩素酸ナトリウム溶液（BIA Infectant solution に相当）を装置左側の

インレットチューブ用（15ml）に設置 

 

・（Step4）同様に超純水をインレットチューブに設置 
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5-2. システムチェック 

A. 実施頻度等 

実施頻度 装置の自己診断。装置の調子が悪いことが疑われるとき。実験が正しく測定できているかを

担保するための定期的な実施頻度に設定 

Wizard Menu bar の Tools → More Tools…内 System Check and Pump Calibration 

 

 

B. 準備する試薬、消耗品・注意点 

Desorb : (D)  
Desorb and Sanitize (D&S) 

必要試薬・消耗品 

BIAtest solution BIAmaintenance Kit 内 

 

HBS-EP＋ Buffer 150 ml 程度 

Sensor Chip CM5 新品（実行後、実験に使用可能） 

 

超純水  
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C-1. System Check の手順 

手順 説明 

チップのドック 新品のセンサーチップ CM5、HBS-EP＋をランニングバッファーとし Prime 

温度設定 25℃に設定 

ウイザードの実行  

結果の確認 ・正常範囲内：PASS  範囲外：FAIL 

FAIL の表示が出たときには弊社サポートまでご連絡ください。 
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5-3. シャットダウン 

実験が終了した際には、次のいずれかの方法でシステムを維持できます。 

スタンバイ状態で放置  7 日以内に使用する場合 

電源を落として終了  7 日以上使用しない場合 

 

5-3-1. スタンバイ状態での放置 

測定が終了すると、自動的に Standby flow 状態になります。 

チューブ A にセットしたランニング緩衝液で、65 ml/ 24 時間の流速を最長 7 日間継続します。ランニング

バッファーを涸らさないように注意してください。廃液ボトルの空き容量にも注意してください。 

スタンバイ状態であるか否かは、ウインドウ下の Status bar で確認できます。 

 

5-3-2. 電源の落とし方 

電源を落とす前には、メンテナンスを実行してください。 

Toolbar の Eject アイコン（  ）または Menu bar の Tools → Undock Chip…を選択します。 

↓ 

 

Undock Chip をクリックします。 

↓ 

センサーチップを取り出し、Biacore X100 control software を終了します。 

Windows の Start メニューから、All Programs→Oracle Database 11g Express Edition→Stop 

Database を実行します。 

 

パソコンのシャットダウン、Biacore X100 の本体電源を落とします。 

注意）電源を落とす場合は、システム内部が超純水で置き換わっているかどうか確認の上、電源を落と

してください。 
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5-3-3. センサーチップの保存 

取り出したセンサーチップは、以下の 2 つの方法で保存できます。 

リガンドは保存中に変性する可能性があるので、再使用の際にはポジティブコントロールサンプルのレスポ

ンスからリガンドの活性を確認してください。また、再 Dock 時前には、検出面、固定化面に埃などの汚れ

が付着していないことを確認してください。 

 

ドライ状態での保存 

取り出したセンサーチップにパラフィルムを巻いて 4℃で保存します。 

安定なサンプルを固定したセンサーチップの保存に用います。 

 

ウェット状態での保存 

取り出したセンサーチップのシート部分をカバーから抜き取り、シートだけを容器（50 ml 容のふた付きプラ

スチック遠心チューブ等）に分注した HBS-EP+などの緩衝液に浸し、4 ℃で保存します。 

 

シートの取り出しと保存 

センサーチップはカバーとシートから構成されています。 

 

シートの金基板の窪んでいる面はリガンドが固定化されています。平らな面は検出器が接触します。リガン

ド固定化面には触れないよう注意してください。 

 

 

ピンセットにてシートを抜き出し、緩衝液に浸して保存します。 

 

カバー 

シート 

固定化面は窪んでいる（金膜） 

検出面は平ら（ガラス） 
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保存していたシートからの緩衝液成分の除去とカバーへの収納 

再利用する際は、緩衝液に浸していたシートをカバーに収めます。シートの水分を取り除いてからカバーに

収めてください。 

 

プラスチックの部分および検出面   

キムワイプで拭き、超純水で湿らせたキムワイプで再度拭きます。さらに乾いたキムワイプで拭きます。 

 

固定化面 

キムワイプなどを“こより状”に細くして、金基板の中央部分に触れないように、四隅から水分を吸収します。 

 

埃に注意しながらカバーに収めます。下図のように、検出面が表になる向きで、ピンセットにてカバーの左

側から挿入します。 

＊リガンド固定化面を表にして挿入した場合には最後までシートが入りません。 
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6-1. アミンカップリング 

A. 手順概略 

手順 操作項目 参照 

①  リガンド希釈液の pH 選択 ・中性タンパク質：等電点の pH0.5~2.0 低い

Acetate 

・塩基性タンパク質：トリス、グリシンなど一級アミン

を含まない中性緩衝液。 

・酸性タンパク質：アミンカップリング不可→Biotin

化（6-4 参照） 

・Capture kit は付属の Acetate 

・不明な場合は、Wizard から pH Scouting 実施

（6-1C 参照） 

②  センサーチップの選択 ・CM5→アミンカップリングの第一選択 

・C1、CM3、CM4→デキストランへの非特異を減ら

す。固定化する分子が大きい場合（細胞など）。 

・PEG→固定化を極限まで下げて、デキストランへの

非特異を減らす 

・CM7→CM5 で固定化が足りない場合 

③ Wizard テンプレートを用いた固定化 6-1D 参照 

 

B. 準備する試薬・サンプル 

各センサーチップの Instruction For Use (IFU)を併せてご参照ください 

Amine Coupling Kit (BR100050)* 

各種リガンド希釈液 

一般的に固定化するタンパク質は数十 μg/ml オーダー程度が適当ですが、サンプルや目標とする固定化

量により異なります。 

＊Amine Coupling Kit の NHS および EDC は超純水に溶解後、凍結保存します。100 μl 程度バイアル

に小分けにすることをお勧めします。Biacore 8K/8K+の場合、PCR 8 連チューブが便利です。 
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C. ソフトの操作のポイント ～ pH Scouting  

使用すべきリガンド希釈液が不明な場合、はじめに pH Scouting を行います。 

Wizards から、Surface preparation→Immobilization pH Scouting→New 

Assay Workflow を作成している場合は、Find Immobilization pH→Run to find out 

手順 操作項目 注意点・説明 

① Fc の選択  

② Buffer name 使用する希釈液名称 

③ pH 使用する希釈液の pH 

④ リガンド添加時間・流速 通常 60秒、5μl/分 

⑤ センサーチップ洗浄液 通常 50mM NaOH 

  

 

下図のようなセンサーグラムが得られます。プレコンセントレーションによるレスポンスが確認できる希釈液の

うち最も pH が高いものを採用します。この場合は、10 mM Acetate pH 5.0。 
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D. ソフトの操作のポイント ～ Amine Coupling  

Wizards から、Surface preparation→Immobilization→New 

手順 操作項目 注意点・説明 

① センサーチップの選択  

② Prime before run 起動後、Prime 実施済みであればチェックを外す 

③ 固定化 Fc の選択 ＊キャプチャー用分子（抗体など）の場合は、使用する全ての

Fc を選択。同一条件で固定化。 

④ 固定化アプローチの選択 固定化量を下げて制御したい場合は Aim・・・を使うこともある 

⑤ 固定化メソッドの選択 Amine を選択 

⑥ リガンド名称・添加時間 通常 420 秒 

 

 

E. 固定化量の確認と理論的 Rmax の算出 

方法 状況 固定化量の確認法 

① Wizard を利用 測定結果のウインドウ（Response Bound と Response Final）

で確認する。 

② Manual run を利用 
リファレンスライン  を用いて確認する（6-5 参照） 

 

 

 

① ② 

③ 

④ 

⑤ 

⑥ 
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補足. 固定化量の評価 

固定化量として Response Bound と Final の 2種類が表示される。 

レスポンスが小さい方を固定化量として採用する。 

固定化量 注意点・説明 

Response Bound リガンド添加前後のセンサーグラムの高さの差 

Response Final NHS/EDC 添加前からエタノールアミン添加終了後の差 

 

リガンドがアグリゲーションしている場合やセンサーチップ表面に吸着する場合は、エタノールアミンを添加す

ることにより、非共有結合でセンサーチップ表面に残ったリガンドは洗い流されるため、Final のレスポンスは

Bound より小さくなる。 

また、極めて固定化量が少ない場合は、NHS 化した部分の大半に（一部はリガンドが導入されている）

エタノールアミンが導入されるため、Final のレスポンスは Bound より大きくなることがある。 

いずれの場合も、レスポンスが小さい方を固定化量として採用する。 

 

理論的 Rmax [RU]= 固定化量[RU]×（アナライトの分子量/リガンドの分子量）×リガンドの結合価数 

アナライト添加時に十分なレスポンスが得られるか、実際にアナライトを添加したときのレスポンスが結合部

位特異的かどうかなどを見積もるために利用します。 
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 6-2. アナライトの添加条件設定 

アナライトは、通常、Rmax 近くからギリギリレスポンスが得られる範囲で、～3 桁程度の添加濃度レンジ

で添加します。濃度 5 点を取る場合、3 倍希釈シリーズ程度です。 

 

A. 添加、解離時間の目安 

 Kinetics Affinity 

添加時間 

結合・解離が緩やかなセンサーグラム： 

2-5 min 

箱型に近いセンサーグラム： 

1-2 min 

結合・解離が緩やかなセンサーグラム： 

（結合相で平衡にならない場合）適用不可 

箱型または箱型に近いセンサーグラム： 

1-2 min 

解離時間 

結合・解離が緩やかなセンサーグラム： 

～90 min 

箱型に近いセンサーグラム： 

1～2 min 

不要（30 秒程度で設定） 

濃度点数 5 8 程度 
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B. Manual Run による条件検討 

Manual run （2-2 参照）を実行します。 

手順 操作項目 注意点・説明 

① Flow rate はじめに添加するサンプルの流速を決めます。 

② Flow path 使用する Flow path の選択。 

③ Start 測定開始 

 

 

ベースラインのセンサーグラムが現れます。 

 

 

 

 

 

① 

② 

③ 
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 操作項目 注意点・説明 

① 
 流速の変更 

通常、リガンドキャプチャには 10μl/min.、アナライト添加には

30μl/min.以上 

 

 流路の切り替え 
リガンドキャプチャにはアクティブセルのみ（Fc2,4 など）、アナライ

ト添加にはリファレンス-アクティブセル（Fc4-3、2-1 など） 

 
（赤）サンプル添加 

キャプチャーリエージェント、リガンド、アナライトの添加 

＊クリックすると、添加時間に応じた必要液量が確認できます。 

 

（青）再生溶液添加 
再生溶液の添加 

＊クリックすると、添加時間に応じた必要液量が確認できます。 

 
 待機 

次の操作コマンドを実行するまでの時間を任意で設定 

 

 ラックの取り出し 
サンプルの分注を行う。 

 

サイクルの切り替え 
検出セルの変更も可能 

 
 測定の終了 

 

 
 一時停止 

 

② センサーグラム リファレンス、アクティブ、アクティブーリファレンス 

③ レポートポイント サンプル、再生溶液添加後にレポートポイントを得ます。 

 

① 

③ 

② 
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（例）Biotin CAPture Kit、流速 5 μl/min.、Flow path 2-1 で開始した場合 

各センサーチップの Instruction For Use (IFU)を併せてご参照ください 

Sensor chip CAP は初回 Rehydration、Conditioning が必要です。 

① をクリック、任意のバイアルで Biotin CAPture Reagent を 5分（5 μl/min）添加する際の必

要量を確認。 

② をクリック、Biotin CAPture Reagent を必要量セット。 

③ をクリック、②でセットしたポジションと液量に間違いがないことを確認し、OK。 

④ Fc1、Fc2 に 2500～5000 RU 程度の Biotin CAPture Reagent レスポンスが確認できます。 

⑤ をクリック、流路を Flow path 2 のみにします。 

⑥ をクリック、流速を 10 μl/min程度とします。 

⑦ をクリック、Biotin 化リガンドを添加する際の必要量を確認（数十 μg/ml、60-120sec.程度

から検討）。 

⑧ をクリック、Biotin化リガンド溶液を必要量セット。 

⑨ をクリック、⑧でセットしたポジションと液量に間違いがないことを確認し、OK。 

⑩ Fc2 に目標の Biotin 化リガンドのレスポンスが出るか確認。 

⑪ をクリック、流路を Flow path 4-3 にします。 

⑫ をクリック、流速を 30 μl/min以上とします。 

⑬ をクリック、アナライトを添加する際の必要量を確認（濃い目の濃度で、60-120sec.程度から

検討）。 

⑭ をクリック、アナライト溶液を必要量セット。 

⑮ をクリック、⑭でセットしたポジションと液量に間違いがないことを確認し、OK。 

⑯ Fc1 に非特異的結合がないこと、Fc2-1 で理論的 Rmax 近くまでレスポンスが出ていることを確認

（6-6 参照）。 
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⑰ をクリック、流速を 5～30 μl/min とします（任意）。 

⑱ をクリック、任意のバイアルで Biotin CAPture Kit 付属の再生溶液を 2分添加する際の必要

量を確認。 

⑲ をクリック、アナライト溶液を必要量セット。 

⑳ をクリック、⑲でセットしたポジションと液量に間違いがないことを確認し、OK。 

㉑ Fc1、Fc2 で、ベースラインがはじめの高さに戻ることを確認します。 

 

Biotin CAPture Kit では、アクティブセル（Fc2）において下図のようなセンサーグラムが得られます。 
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6-3. 再生条件の設定 

アミンカップリングによる Sensor Chip CM5 などの直接固定、または、Sensor Chip SA を用いた場合、リガ

ンドとアナライトを完全に外す再生条件を設定する必要があります。 

再生条件として、以下の二点が重要です。 

① アナライトが完全に外れてベースラインまで戻ること。 

② 同じアナライトをインジェクションした際に同等のレスポンスが得られる（リガンドが失活しない）こと 

 

候補となる再生方法がある場合、マニュアルランにより確認を行います（6-２B 参照）。情報がない場

合、Regeneration Scouting を用います。 

 

A. 手順概略 

手順 操作項目 参照 

① リガンド固定化済みのセンサーチップを用意 ・アミンカップリング（6-1 参照） 

・Sensor Chip SA（4-1 参照） 

③ Wizard テンプレートを用いた Regeneration Scouting 6-3D 参照 

 

B. 準備する試薬・サンプル 

Regeneration Scouting Kit の Instruction For Use (IFU)を併せてご参照ください 

Regeneration Scouting Kit（BR100556） 

リガンド固定化済みのセンサーチップ 

アナライト溶液 

ランニング緩衝液 

 

C. ソフトの操作のポイント 

Wizards から、Assay Development→Regeneration Scouting→New 

Assay Workflow を作成している場合は、Find Regeneration Condition→Run to find out 

手順 操作項目 注意点・説明 

① Injection Sequence Fc/ Sensor Chip の選択 

② System Preparation 通常、未入力のまま 

③ Injection Parameter アナライト名称、通常 60-120 秒 

④ Stabilization period 次サイクルへの待機時間 

⑤ Number of Condition 評価する再生条件の数 

⑥ Number of Cycle for each 通常 5 回程度繰り返し、失活の様子などを評価する。 

⑦ Setting 再生溶液名称、コンタクト時間 
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下図のような Result が得られます。複数回の Injection により、Baseline まで戻り、同じアナライトをイン

ジェクションした際に同等のレスポンスが得られる条件を採用します。 

 

 

 

 

 

⑤ 

5 

④ 

⑥ 

⑦ 
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6-4. リガンドの Biotin 化 

Biotin化試薬を用いた一例を示します。 

 

A. 手順概略 

手順 操作項目 注意点・説明 

① Biotin化反応 ・ タンパク質サンプル:HNS-Biotin＝1:1.5（モル比）で混和 

・ 室温 1 時間、または、4℃で o/n 

② 遊離 Biotin の除去 ・ ゲルろ過による除去、または、限外濾過膜による濃縮 

 

B. 準備する試薬・サンプル 

EZ-Link™ NHS-LC-Biotin (21336 *Thermo Fisher, 50 mg） 

EZ-Link™ Sulfo-NHS-LC-Biotin, No-Weigh™ Format (A39257 * Thermo Fisher Scientific, 10 x 1 mg） 

PD SpinTrap G-25 (28918004) 

Vivaspin 500-3K (28932218) 

HBS-N 10X（BR100670） 

 

C. Biotin 化、遊離 Biotin の除去手順 

① Biotin化反応 

10mM NHS-Biotin in DMSO ストック溶液作成 

タンパク質サンプル:HNS-Biotin＝1:1.5（モル比）で混和 

室温 1 時間、または、4℃オーバーナイトで静置 

 

② 遊離 Biotin の除去 

②-1 PD SpinTrap G-25 によるフリービオチンの除去 

 Sephadex G-25担体の入ったカラムを Vortex 

 先端を折って、キャップを切り取った 1.5ml チューブにセット 

 1 min at 800 × g で保存溶液除去 

 400 μl HBS-N を添加。1 min at 800 × g で平衡化。5 回繰り返し。 

 平衡化済みのカラムを、付属の回収用チューブにセット 

 Biotin 化サンプル 140-180 μl を、2 min at 800 × g で精製 

 カラムを除いて、付属のキャップを締める。  

 

②-2 Vivaspin 500-3K によるフリービオチンの除去（ビオチン化サンプルの濃縮） 

 Biotin 化反応後、500 μl にアップ 

 30 min at 12,000 × g で濃縮  



 

47 
 

 残量 100 μl 程度になるように＋10 分程度  

 濃縮済みの溶液をマイクロチューブに回収。もとの液量になるように HBS-N を追加。 

 

＊各試薬および精製カラムの Instruction For Use (IFU)を併せてご参照ください 

 

6-5. リファレンスライン 

マニュアルによる固定化、特異的反応の確認などを行った場合、リファレンスラインを用いてレスポンスを確

認します。 

手順 操作項目 注意点・説明 

① Reference Line 
 をクリックします。 

② ベースラインの選択 レスポンスを確認したいセンサーグラムのベースラインをクリック 

③ F9 をタップ 選択されたポジションが 0（RU）となります。 

もう一度 F9 をタップすると絶対値に戻ります。 

④ レスポンスの確認 レスポンス（RU）を確認したい箇所へリファレンスラインを移動さ

せます。③のウインドウに数値が表示されます。 

 

 

 

 

 

 

 

① 

② 

③ 

④ 
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6-6. 溶媒（DMSO）補正（Solvent Correction） 

低分子化合物のストック溶液は、多くの場合 DMSO に溶解されているため、アナライト溶液として数％程

度 DMSO を含んだ状態で測定することになります。ランニング緩衝液とアナライト溶液中の DMSO 濃度

1%の違いは約 1,200 RU のバルクレスポンスに相当するため、ランニング緩衝液とアナライト溶液中の

DMSO 濃度を揃えていただくことが重要です。 

それでも、下図のように 5% DMSO を含むランニング緩衝液中に 5.1% DMSO を含むアナライト溶液が流

れると、120 RU 程度のバルクレスポンスが確認できます。また、厳密に見ると、リガンドが固定化されたセ

ル（アクティブセル）は、リガンド固定化分センサーチップ近傍へアクセスできる DMSO 量が減るため、溶

媒効果のずれが生まれます。これを補正する機能が、溶媒補正（Solvent Correction）です。 

 

A. 溶媒補正の準備 

5 % DMSO 含有サンプルを用いる場合の溶媒補正用 DMSO 溶液の作成方法例を記載します。4.5%

～6%のような 5%を挟んでやや高めの範囲で DMSO 溶液を 4 点～8 点程度セットすることが標準的で

す。特に Biacore8K/8K+では流路構造の工夫により検量線がおおむね直線的になるため、標準設定と

して 4 点になります。それ以外の機種では、設定する DMSO 濃度の範囲の広さ、検量線の直線性、測

定に求める真度と測定時間やバイアル設置個所のバランス、などの要素を考慮して濃度点数を決定して

ください。  

 

すべての DMSO 溶液は用事調製します。 

 

①1.05x PBS-P+を調製します。 

 210 ml 10x PBS-P+ を、超純水で 2000 ml になるように希釈します。 

 

 

120 

0 
5% DMSO 

5.1% DMSO 
5.1% DMSO 

溶媒効果の差 

リファレンスセル アクティブセル 
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②溶媒補正用 4.5 %、6% DMSO 溶液および 5.0% DMSO ランニング緩衝液を調製します。 

 

③ストック溶液を下記表の割合で混合して、4.5%～6%の溶媒補正用 DMSO 溶液を調製します。 

8 段階の溶媒補正用 DMSO 溶液を調製する場合： 

4.5% DMSO  100 200 300 400 500 600 700 

6% DMSO 700 600 500 400 300 200 100   

700  700  700 700 700 700 700 700（μl） 

 

4 段階の溶媒補正用 DMSO 溶液を調製する場合（主に Biacore 8K/8K+） 

4.5% DMSO  1500 2x1500 3x1500  

6% DMSO 3x1500 2x1500 1500 0  

4500  4500  4500 4500（μl） 

 

測定時に Solvent Correction を用い、解析を実行することで下図のような補正曲線の作成およびリファ

レンスセル-アクティブセル間の補正が実行されます。 

 

X 軸：リファレンスセルのレスポンス、Y 軸：リガンド固定化セルーリファレンスセルのレスポンス。Report 

point range：本測定の各検体が示したバルクレスポンス(リファレンスセル）の範囲、Correction range：補

正される最大補正値（RU）～最小補正値 (RU）の範囲 
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6-7. 特異的結合の確認 

測定値の評価、フィッティング解析を行う前に、取得したセンサーグラムが”結合部位特異的”な相互作用

を反映したものであるか確認することが重要です。 

 

A. 差し引き後のセンサーグラムからの確認（Fc2-1） 

以下の様子が確認された場合、非特異的な背結合成分が含まれていると考えられます。 

手順 確認項目 注意点・説明 

① 平衡値の確認 平衡値に達しているべきセンサーグラムで、特に高濃度帯の結合相で

平衡値に達しないでダラダラと上昇していないか？ 

② 理論的 Rmax の確認 その上昇が理論的 Rmax（これ以上結合しないという飽和点）を超

えていないか？ 

③ 解離相の確認 特に高濃度帯の解離相で最初は速やかに下降するのに、そのあとな

かなかベースラインまで落ちない二相性の形状になっていないか？ 

 

 

B. リファレンスセルに対する非特異的結合の確認 

詳細を確認するためには、まず、リファレンスセルのみを確認します。 

手順 確認項目 注意点・説明 

① Curve Type の選択 Curve Type として Reference と Active 個別のセンサーグラムを選択

します。 

② Reference の確認 Reference のセンサーグラムに箱型のバルクレスポンス以外の、非特異

結合が無いことを確認します。 

 

 

① 
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C. 結合部位特異的な結合であるかの確認 

続いて、その結合が結合部位特異的なものであるかという点も重要です。アナライトの濃度を複数点とっ

た時に、実測 Rmax が、理論的 Rmax（4-1E 参照）以下で飽和することを確認します。 

 

 

 

 

 

 

② 
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6-8. Keyword Table によるサンプル名、濃度などの修正 

サンプル濃度および濃度単位、サンプルの名称など入力ミスがあった場合、Evaluation Software から

Tools… → Keyword Table…をクリックします。 

手順 確認項目 注意点・説明 

① Concentration Unit 濃度単位に入力ミスがあった場合、解析実行前に編集します。 

② Table サンプル濃度、サンプルの名称など入力ミスがあった場合、解析実行

前に編集します。 

 

 

 

② 

① 
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6-9. フィッティングモデル式と parameters の設定 

6-9-1. Kinetics 解析 

A. フィッティングモデル式と parameters の設定方法 

Tool bar の を選択、 を実行（4-3D 参照） 

手順 確認項目 注意点・説明 

① Model 実際の反応様式に沿ったモデル式を選択（6-9-1B 参照） 

② Parameters 下図は Default 値（6-9-1C 参照） 

                                    

 

B. Kinetics解析の反応モデル 

KD値は 1:1 結合の上で成り立つ数値のため、可能な限りアッセイを 1:1 の系にしていただき、 1:1 Binding

のモデル式を選択することをお勧めします。 

モデル式 説明 

1:1 Binding A + B ⇔ AB 

リガンドとアナライトが 1 分子同士で結合するもっとも単純な反応モデル。 

Bivalent Analyte A + B ⇔ AB , AB + B ⇔ AB2 

アナライトが 2 価もしくはホモ 2 量体の反応モデル。AB 複合体形成後、リガン

ド B が 2 次的に結合する反応。 

Heterogeneous 
Analyte 

A1 + B ⇔ A1B , A2 + B ⇔ A2B 

競合反応。リガンド上の 1 種類の結合部位を 2 種類のアナライトが競合す

る反応。 

Heterogeneous Ligand A + B1 ⇔ AB1 , A + B2 ⇔ AB2 

アナライトに対して親和性の異なる 2 つの結合部位を持つリガンドにアナライト 

が並行して結合する反応モデル。 

Two state Reaction A + B ⇔ AB ⇔ AB* 

リガンドとアナライトの 1 分子同士の結合であるが、複合体形成後コンフォメ

ー ション変化を起こす反応モデル。 

 

① 

② 
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C. Parameter Setting の使用方法 

各パラメータに対して以下の設定が可能です。 

項目 説明 

Fit Fit Global：複数濃度のセンサーグラムで１つの解を求めます。 

Fit Local：各濃度のセンサーグラムでそれぞれ解を求めます。 

Constant：固定値。 

Initial Value ・ Fitting 解析をはじめる初期値を設定。 

・ Constant と併せて固定値を設定。 

各パラメータに対する主な変更点。Default のまま実施するケースも多いです。 

モデル式 説明 

ka 多くの場合、変更はしない。 

kd 解離が遅いもので、真値と明らかに異なる値が出た場合、1e-5 くらいからはじめるこ

ともある。 

Rmax 通常は Fit Global。再生が不十分でサイクルごとに Rmax が変わる際、Fit Local を

使用するケースがある。 

tc 多くの場合、変更はしない。 

RI 箱型に近いなどセンサーグラムの形状によっては実際のレスポンスを RI として計算し

てしまうことがあるため、Constant０にしたほうがいい場合がある。 

 

6-9-2. Affinity 解析 

A. フィッティングモデル式と parameters の設定方法 

Tool bar の を選択、 を実行（4-3D 参照） 

手順 確認項目 注意点・説明 

① Model 実際の反応様式に沿ったモデル式を選択（6-9-2B 参照） 

② Parameters 下図は Default 値（6-9-2C 参照） 

  

 

① 

② 
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B. Affinity解析の反応モデル 

Steady State Affinity が選ばれます。KD値は 1:1 結合のもとで求められる数値ですので、1:1 の結合様

式であるとしてフィッティングの計算がされます。 

モデル式 説明 

Steady State Affinity 

 
1:1 Binding モデルで、Rmax は Fitting パラメータ。 

 

C. Parameter Setting の使用方法 

各パラメータに対して以下の設定が可能です。 

項目 説明 

Fit Fit Global：複数濃度のセンサーグラムで１つの解を求めます。 

Fit Local：各濃度のセンサーグラムでそれぞれ解を求めます。 

Constant：固定値。 

Initial Value ・ Fitting 解析をはじめる初期値を設定。 

・ Constant と併せて固定値を設定。 

各パラメータに対する主な変更点。Default のまま実施するケースも多いです。 

モデル式 説明 

ka 多くの場合、変更はしない。 

Rmax 通常は Fit Global。再生が不十分でサイクルごとに Rmax が変わる際、Fit Local を

使用するケースがある。 

offset 多くの場合、変更はしない。 
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6-10. 解析結果の品質評価 

Evaluation Software は、フィッティングの品質評価を行う機能があります。十分に注意いただきたい点とし

て、これはあくまでフィッティング計算における品質評価です。まずは見たいものを反映しているセンサーグラ

ム形状になっているか、そのためのアッセイセットアップが何より重要です（6-7 参照）。 

6-10-1. Kinetics 解析 

A. Quality Control タブ 

手順 確認項目 注意点・説明 

① 速度定数がシステムのスペック範囲

内か？ 

Biacore T200 のスペック範囲 

ka =1e3～1e9、kd =1e-5～1 

② 各パラメータが独立して算出されて

いるか？ 

ka、kdおよび Rmax の間に相関性はない。 

マストランスポートリミテーション下で ka、kdに相関性 が見

られる。 

③ 溶液効果の値（RI）の妥当性 リファレンスセルおよびアナライトのゼロ濃度を差し引によっ

て RI は ゼロに近い値となるはず。 

④ センサーグラムはカーブを描いている

か？ 

高濃度サンプルに注目。センサーグラムの結合・解離領

域が直線的な場合、Fitting結果の信頼性は低い。 

⑤ フィッティングカーブに対して測定プロ

ットがランダムに分散しているか？ 

Residuals タブを確認（6-10-1B 参照） 

 

 

ステータスマーク 

（緑）クオリティーアセスメントにパスしています。 

（黄）クオリティーアセスメントの許容限界に近いです。 

（赤）クオリティーアセスメントにパスしていません。 

（青）測定者が確認します。 

① 

② 

③ 

④ 

⑤ 
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B. Residuals タブ 

フィッティングカーブをゼロ一直線にした際の各データのばらつき具合を示します。良好なフィッティングでは、

ランダムにプロットが分散しており、ガイドライン内にほぼ全てのプロットが収まっています。残差プロットに偏り

が見られる場合、良好なフィッティングであるとは言えません。 

 

Residuals for a good fit   Residuals for a poor fit 

 

C. Report および Parameters タブ 

解析結果として以下のパラメータが算出されます。 

   単位 説明 

1:1 binding 

model 式の 

変数 

結合速度定数 

ka 
1/Ms 

複合体形成速度。1M の A と B を混合した際に形成

する複合体の数。 

解離速度定数 

kd 
1/s 

複合体の安定性。複合体が 1 秒間に解離する割合。 

kd = 0.01 s-1= 1% 1秒当たり複合体が 1%解離する。 

解離定数 

KD 
M 

アフィニティーは平衡状態においてどれだけの複合体が

形成されているかを表す。 

Rmax RU アナライトの最大結合量。 

溶媒効果 

RI 
RU 

バルクレスポンスを引いた時に、ゼロからわずかにずれる

誤差値。 

＊本来は極めて 0 に近い値をとるべき値 

tc 値 RU⋅M-1s-2/3m-1 

tc=kt/3√ f マストランスポート（MTL）定数（kt）の

流速非依存性コンポーネント 

＊どれだけ MTL が強くかかっているかと算出しているかの

指標。この値が小さい場合、センサーチップ表面に到達

するアナライトの実際の濃度は低くなっていると計算され

ている。 
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Fitting 解に 

対する評価 

パラメーター 

カイ二乗 

Chi2 
RU2 

測定データフィッティングカーブ間の差を示す。 

良好なフィッティングで は、シグナルノイズの平均平方値

に一致。 

U-value - 

解析値の信頼性。≦15 問題なし。 ≧25 算出された

値の信頼性は低い。 

＊既存の 1:1 Binding モデル使用時のみ 

標準誤差 

SE 
- 

各パラメータについて SE を算出。 

各パラメータの解析結果に対して、10%以下で一般的

には問題ないと判定されることが多い。 

6-10-2. Affinity 解析 

A. 信頼性の確認 

信頼性の高い解析結果を得るためには、アナライトの最高濃度が KD値の 2 倍以上で添加されているこ

とが必要です。この基準を満たしていない場合、KD値のラインが赤色で表示されます。 

 

 

B. Report および Parameters タブ 
 

  単位 説明 

1:1 binding model 式の 

変数 

解離定数  

K
D
 

M 
アフィニティーは平衡状態においてどれだけの複合体が形

成されているかを表す。 

Rmax RU 
アナライトの最大結合量。実際にアナライ添加した時、

結合量が飽和する レスポンス。 

Offset RU X = 0 の時の Y 軸の値 

Fitting 解に対する 

評価パラメーター 

カイ二乗 

Chi
2

  
RU

2

 
測定データとフィッティングカーブ間の差を示す。良好なフ

ィッティングで は、シグナルノイズの平均平方値に一致。 

 

KD：信頼性が高い 

KD：信頼性が低い 
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6-11. 用語集 

2D-kinetics 2D カイネティ

クス 

8K/8K+で用いる測定方法の一つ。複数ニードルと複数サイクルで広

範囲な濃度で一度に測定する。 

Active Cell リガンド固定

化セル 

Flow Cell のうち、リガンドを固定するセル 

Affinity 平衡値解析 各アナライト濃度の結合相における平衡値プロットから 1/2Rmax に

相当するアナライト濃度に相当する KD 値を算出。結合・解離の速い

相互作用を示すセンサーグラムの解析手法。 

Affinity アフィニティー 分子の 1:1 結合における親和力（KD値）。 

Amine 
Coupling 

アミンカップリ

ング 

分子の一級アミンを利用して、センサーチップにリガンドやキャプチャー

分子を直接固定化する一般的な手法。 

Analyte アナライト Biacore において送液する側のサンプル。 

Association 結合 アナライトを送液して、センサーチップ上のリガンドとアナライトが結合す

ること。 

Avidity アビディティー 多価分子のおける親和力の総量。 

Bulk Effect 溶液効果 ランニング緩衝液に対して密度の異なる溶液を添加すると、レスポン

スが生じる現象。 

Capture キャプチャー リガンドを捕捉する分子をセンサーチップに固定化し、間接的にリガン

ドをセンサーチップに結合させること。 

Capturing 
molecule 

キャプチャー

分子 

センサーチップへリガンドを間接的に固定化するための捕捉用分子。リ

ガンドの再生が可能となる。 

Channel チャンネル 8K/8K+における、各ニードルに対応する測定番号。 

Chi2 カイ二乗 測定データフィッティングカーブ間の差（平均平方値）を示す。 

Contact Time 添加時間 リガンド、アナライトなどをインジェクションする時間。 

Desorb デゾルブ IFC およびサンプルチューブを洗浄するプログラム。週一回の実施を推

奨。 

Desorb and 
sanitize 

デゾルブアン

ドサニタイズ 

すべてのフローシステムの滅菌および洗浄するプログラム。月一回の実

施を推奨。 

Direct 
Immobilization  

直接法 センサーチップにリガンドを直接固定化する方法。主にアミンカップリン

グを指す。 

Dissociation 解離 アナライトの送液を止めて、センサーチップ上のリガンドとアナライトが解

離すること。 

Experimental 
Rmax 

実測 Rmax 実際にアナライトを添加した時、結合量が飽和する レスポンス(RU) 

Fit フィッティング

解析 

非線形最小二乗法により変数となる ka、kd、Rmax などを算出する

解析方法。 
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Fitting Model 反応モデル フィッティング解析を行う際のモデル式。 

Flow Cell 

（Fc） 
フローセル センサーチップ上でマイクロ流路から送液された溶液と接液する箇所。

反応・検出の場。通常、Active Cell と Reference Cell を持つ。 

Foil フォイル Biacore で 96/384 ウェルプレートを用いる際のプレートシール

（Pooling 不可） 

Immobilization  固定化 センサーチップにリガンドを結合させる操作。Capture（キャプチャー）

との総称として用いることもある。 

Injection インジェクショ

ン 

ニードルを用いたサンプルの添加。 

Integrated 
Microfluidic 
Cartridge (IFC) 

マイクロ流路

系 

カートリッジ形式のマイクロ流路系。センサーチップと接する個所にフロ

ーセルを形成する。 

ka (kon) 解離速度定

数 

複合体の安定性。複合体が 1 秒間に解離する割合（1/s）。 

kd= 0.01 s-1= 1% （1秒当たり複合体が 1%解離する）。 

KD 解離定数 平衡状態においてどれだけの複合体が形成されているかを表す

（M）。 

kd (koff) 結合速度定

数 

複合体形成速度。1M の A と B を混合した際に形成する複合体の

数（1/Ms ）。 

Kinetics カイネティクス

解析 

反応速度論的解析。センサーグラムの形状を評価し、ka、kd を算出

する解析手法。 

Ligand リガンド Biacore においてセンサーチップに固定化する側のサンプル。 

Mass 
Transport 
Limitation

（MTL） 

マストランスポ

ートリミテーシ

ョン 

アナライトの供給が追いつかず、消費速度が上回る現象。センサーグ

ラムの変形が生じるため、固定化量を下げるとともに流速も高流速

（30 μl/min）にする。 

Multi cycle 
kinetics 

マルチサイク

ル法 

各アナライト濃度を個別サイクルで測定する方法。 

Parallel 
kinetics 

パラレルカイ

ネティクス 

8K/8K+で用いる測定方法の一つ。複数ニードルで一度に複数濃度

を測定する。 

Pre-
Concentration  

プレコンセント

レーション 

アミンカップリングにおいて、リガンドの等電点より 0.5~2.0 程度低い

pH の溶媒を用いることでセンサーチップ近傍へ静電的に濃縮させる

効果。 

Quality 
Control 

クオリティーコ

ントロール 

フィッティング解析終了後に Evaluation Software が示すフィッティング

の品質評価。 

Reference Cell リファレンスセ

ル 

Flow Cell のうち、リガンドを固定化しないセル（溶液効果の補正

用） 

Regeneration 再生 センサーチップに固定化されたリガンドからアナライトを強制的に全て解

離させる操作。リガンドごと解離させる場合もある。 
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Residuals 残差プロット Evaluation Software が示すフィッティングの品質評価の一つで、フィッ

ティングカーブに対する測定データのズレを示す。 

Resonance 

Unit（RU） 
レゾナンスユ

ニット 

Biacore の測定によって得られるレスポンスの単位。 

RI 溶媒効果 バルクレスポンスを差し引いた時に、ゼロからわずかにずれる誤差値。 

Rmax アールマックス アナライトの最大結合量。Theoretical Rmax（理論的 Rmax）と

Experimental Rmax（実測 Rmax）がある。 

Sensor Chip センサーチップ リガンドを固定化し、分子間相互作用の場となる Biacore 専用の消

耗品。全 15 種類程度。 

Sensorgram センサーグラ

ム 

Biacore から得られる、結合、解離の様子を反映した測定データ。 

Septa セプタ Biacore で 96/384 ウェルプレートを用いる際のゴム製プレートシール

（Pooling 可） 

Serial kinetics シリアルカイネ

ティクス 

8K/8K+で用いる、Single cycle kinetics と Multi cycle kinetics の総

称。同一のニードルで各濃度をとる。 

Similarity 同等性 EC50 、 PLA な ど の ポ テ ン シ ー ア ッ セ イ 、 ま た 、 Sensorgram 

Comparison による結合様式の類似性評価。 

Single cycle 
kinetics 

シングルサイ

クル法 

各アナライト濃度を同一サイクルで測定する方法。 

Solvent 
Correction 

溶媒補正 アナライトに DMSO などのバルクレスポンスが大きな溶媒を含む際に生

じる、Active Cell と Reference Cell における溶液効果のズレを補正

すること。 

Surface 
Plasmon 
Resonance

（SPR） 

表面プラズモ

ン共鳴法 

表面への分子の結合・解離を金膜表面近傍の屈折率変化として非

標識かつリアルタイムで追跡できる方法。 

System Check システムチェッ

ク 

装置の診断をおこなうプログラム。  

tc 値 ティーシー値 どれだけ MTL が強くかかっていると算出しているかの指標。この値が小

さい場合、センサーチップ表面に到達するアナライトの実際の濃度は

低くなっていると計算されている。 

Theoretical 
Rmax 

理 論 的

Rmax 

固定化したリガンド分子にアナライトが全て結合した時に得られる理

論上最大のレスポンス(RU) 

Thermodynami
cs 

熱力学的解

析 

Δh エンタルピー、Δs エントロピーといった熱力学的パラメーターに基づ

いて、分子間の結合様式情報を得る解析方法。 

U-Value ユーバリュー マストランスポートリミテーションを反映する解析値の信頼性。≦15 問

題なし。 ≧25 算出された値の信頼性は低い。＊1:1 Binding モデル

使用時のみ 
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■総合お問合せ窓口 
 

TEL : 03-5331-9336 
 

● 機器アフターサービス 
（営業日の 9:00～17:30、音声案内に従い①を選択） 

FAX : 03-5331-9324（常時受付） 

● 製品技術情報に関して 
（バイオダイレクトライン、営業日の 9:00～12:00、13:00～17:30） 

音声案内に従い②を選択後、対象の製品別の番号を押してください。 

❶：ÄKTA、クロマトグラフィー関連製品 

❷：ビアコア関連製品 

❸：電気泳動関連製品、画像解析装置 

❹：IN Cell Analyzer、ワットマン製品、その他製品 

e-mail : Tech-JP@cytiva.com（常時受付） 

● 納期／在庫お問合せ 
（営業日の 9:00～12:00、13:00～17:30、音声案内に従い③を選択） 

 

注）お問合せに際してお客さまよりいただいた情報は、お客さまへの回答、弊社サービスの向上、弊社からのご

連絡のために利用させていただく場合があります。 

注）アナログ回線等で番号選択ができない場合はそのままお待ちください。オペレーターにつながります。 

 

www.cytivalifesciences.co.jp 
 

論文に掲載いただく際の名称・所在地 

Cytiva / Tokyo, Japan 
 

グローバルライフサイエンステクノロジーズジャパン株式会社 

〒169-0073 

東京都新宿区百人町 3-25-1 サンケンビルヂング 

お問合せ：バイオダイレクトライン 

TEL : 03-5331-9336 
e-mail : Tech-JP@cytiva.com 

掲載されている内容は 2021 年 8 月現在のもので予

告なく変更される場合がありますのであらかじめご了

承ください。掲載されている社名や製品名は、各社の

商標または登録商標です。お問い合わせに際してお

客さまよりいただいた情報は、お客さまへの回答、弊

社サービスの向上、弊社からのご連絡のために利用さ

せていただく場合があります。 

 

 


